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Creating Address Labels from Microsoft Word Mail Merge 

If you want to send a mass mailing to an address list that you maintain in a Microsoft Office Excel worksheet, you can 

use a Microsoft Office Word mail merge. The mail merge process creates a sheet of mailing labels that you can print, 

and each label on the sheet contains an address from the list. 

To create and print the mailing labels, you must first prepare the worksheet data in Excel and then use Word to 

configure, organize, review, and print the mailing labels. 

What do you want to do? 

 

 Step 1: Prepare the worksheet data in Excel for the mail merge 

 Step 2: Configure the labels for the mail merge in Word 

 Step 3: Link the worksheet data to the labels in the mail merge 

 Step 4: Define the list of recipients that you want to include on the labels 

 Step 5: Populate the labels with placeholders for address information 

 Step 6: Preview and print the labels 

 Step 7: Save the labels for future use 

 

Step 1: Prepare the worksheet data in Excel for the mail merge – You can 
FT Menu 12.2.36 Prompt # 1 R for Report. 

In Excel, your address list must match the tabular structure that mail merge requires. 

1. On a worksheet, do the following to arrange the address list:  

� Use column headers that clearly identify the type of data that each column contains.  

 TIP   For example, use column headers such as First Name, Last Name, Address, and City instead 

of Column 1, Column 2, Column 3, and Column 4. 

� Use a separate column for each element that you want to include in the mail merge.  

 TIP   You can also use the mail merge to create form letters that address each recipient by their first 

name, if you store first and last names in separate columns. You can also add a separate column for a 

title, such as Mr. or Ms. 
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� Include only rows and columns that contain data. Do not include blank rows or columns in the address 

list, because the list of labels that is created might not be complete beyond the blank rows and 

columns when you set up the labels for the mail merge in Word. 

2. To help locate and select the address list during the mail merge, do the following to define a name for the 

address list:  

a. On the worksheet, select the whole address list, including the cells that contain column headers.  

b. On the Formulas tab, in the Defined Names group, click Define Name.  

 

c. In the Name box, type a name for the address list, such as Holiday_Cards, and then click 

OK.  

 TIP   The first character of a name must be a letter, and you cannot use a space between words. 

Instead of a space, use an underscore character (_). 

 Save and close the workbook. 
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Step 2: Configure the labels for the mail merge in Word 

You configure the layout of the labels just once, for all the labels in the mail merge. In a mail merge, the document 

that you configure for the layout is referred to as the main document for labels (or label main document). In this 

document, you can also configure any content that you want repeated on each label, such as a company logo or your 

return address on shipping labels. 

Chances are that you already have a package of label sheets from one of the label sheet suppliers such as Avery, 

AOne, or Formtec. Each label sheet is a certain size and contains a certain number of labels with specific 

dimensions. 

To configure the label main document, you match its dimensions with the dimensions of the labels on the worksheets 

that you plan to use. 
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1. Start Word.  

By default, a blank document opens. Leave it open. If you close it, the commands in the next step are not 

available. 

2. On the Mailings tab, in the Start Mail Merge group, click Start Mail Merge.  

 

3. Click Labels.  

4. In the Label Options dialog box, you have several choices to make. 

 

 

 The type of printer that you are using to print the labels. 

 The supplier that produced your label sheets. 

 The number that corresponds to the product number listed on your package of label sheets. 

 

The product number for my label sheets does not match any one of the choices in the Label Options 

dialog box. 
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1. Measure the labels on the sheet that you are using, and note the measurements and how many labels 

fit on a single sheet.  

 NOTE   Measure the labels carefully. The actual label size might be smaller than the size that is 

indicated by the label manufacturer. For example, a 1-by-2-inch label might actually be 15/16-inch 

high and 1 15/16-inches wide. 

2. In the Product number list, select a label type that is similar in size to your labels.  

If you do not see a substitute label type that you can use in the Product number box, you still might 

be able to use another one of the listed labels. If you don't see a label type that fits your needs, you 

can create a new label size. 

3. Click Details, and then compare the label dimensions and the number of labels per sheet (for labels 

printed on laser and ink-jet printers, also referred to as page printers) or the number of columns on the 

label form (for labels printed on dot-matrix printers, also referred to as continuous-feed printers).  

4. Do one of the following:  

� If the dimensions and label layout match those of your labels, use the selected label.  

� If the dimensions and layout do not match your labels, click Cancel.  

5. In the Label Options dialog box, click the printer type (either Continuous-feed printers or Page 

printers), and then click New Label.  

6. Type a name in the Label name box, select the height, width, margins, and other options for your 

label, and then click OK.  

The new label appears in the Product number box as Label name - Custom. The label is also 

added to the Other/Custom category. The next time that you use your custom labels, make sure that 

you select Other/Custom in the Label vendors list. 

5. After you select the label options that you want, click OK.  

Word creates a document that uses a table to lay out the labels. If you do not see lines separating the labels 

in the layout, click the Layout tab under Table Tools, and then in the Table group, click View Gridlines. 

Interrupt and resume a mail merge 
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If you need to interrupt your work on a mail merge, you can save the label main document as you would any other 

document and resume the merge later. Word retains the data source and field information in the document that you 

save. If you were using the Mail Merge task pane when you stopped working on the merge, Word returns to your 

place in the task pane when you resume the merge. 

1. When you are ready to resume the merge, open the label main document that you saved.  

Word displays a message box that asks you to confirm that you want to open the document and run an SQL 

command (the SQL command connects Word to your Excel source file). 

2. Click Yes to connect to your Excel source file and retrieve your address list.  

The text of your label main document, along with any fields that you inserted, appears. 

3. Click the Mailings tab, and resume your work.  
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Step 3: Link the worksheet data to the labels in the mail merge 

To merge the address information into your labels, you must connect the labels to the worksheet that contains your 

address list. 

1. If this is the first time that you have ever connected to a worksheet, do the following:  

a. Click the Microsoft Office Button , and then click Word Options.  

b. Click Advanced.  

c. Scroll to the General section, and select the Confirm file format conversion on open check box.  

d. Click OK. 

 With the mail merge main document open, in the Start Mail Merge group on the Mailings tab, click 

Select Recipients, and then click Use Existing List.  

 

 Locate the Excel worksheet in the Select Data Source dialog box, and double-click it.  
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 In the Confirm Data Source dialog box, click MS Excel Worksheets via DDE (*.xls), and then click 

OK.  

 NOTE   If you do not see MS Excel Worksheets via DDE (*.xls) in the list, select the Show all check box. 

 In the Microsoft Office Excel dialog box, for Named or cell range, select the cell range or worksheet 

that contains the information that you want to merge, and then click OK. 

 NOTE   The labels are now connected to the worksheet data, but the sheet of labels is still blank. If needed, you can 

define the list of recipients as described in step 4, or you can start populating the labels with placeholders for the 

address information, as described in step 5. 
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Step 4: Define the list of recipients that you want to include on the labels 

Word generates a label for each address in your mailing list. If you want to generate labels for only certain addresses 

in your mailing list, you can choose which addresses (records) to include. 

To narrow the list of recipients or to use a subset of the records in your data file, do the following: 

1. On the Mailings tab, in the Start Mail Merge group, click Edit Recipient List.  

 

2. In the Mail Merge Recipients dialog box, do one of the following:  

� Select individual records  This method is most useful if the list is short. Select the check boxes next 

to the recipients that you want to include, and clear the check boxes next to the recipients that you 

want to exclude.  

 TIP   If you know that you want to include only a few records in your merge, you can clear the check 

box in the header row and then select only those records that you want. Similarly, if you want to 

include most of the list, select the check box in the header row, and then clear the check boxes for the 

records that you do not want to include. 
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� Sort records  Click the heading of the column that you want to sort by. Word sorts the list in 

ascending alphabetical order (from A to Z). Click the column heading again to sort the list in 

descending alphabetical order (Z to A).  

To specify more advanced sorting options, click Sort under Refine recipient list and select your 

sorting preferences on the Sort Records tab in the Filter and Sort dialog box. For example, you can 

specify that recipient addresses must be alphabetized by last name within each postal code, and that 

postal codes are listed in numeric order. 

� Filter records  This method is useful if the list contains records that you do not want to see or include 

in the merge. After you filter the list, you can select or clear the check boxes to include or exclude 

specific records.  

To filter records, do the following: 

1. Under Refine recipient list, click Filter.  

2. On the Filter Records tab in the Filter and Sort dialog box, select the criteria that you want to 

use to filter your records.  

For example, to generate labels only for addresses in Australia, click Country or Region in the 

Field list, Equal to in the Comparison list, and Australia in the Compare to list. 

3. To further refine the filter, click And or Or, and then select more criteria.  

For example, to generate labels only for businesses in Munich, you specify records whose City 

field contains Munich and whose Company Name field is not blank. If you use Or instead of 

And in this filter, your mail merge includes all Munich addresses in addition to all addresses that 

include a company name, regardless of city. 

 NOTE   If you have installed address validation software on your computer, you can click Validate addresses in the 

Mail Merge Recipients dialog box to validate your recipients' addresses. 
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Step 5: Populate the labels with placeholders for address information 

When you perform the mail merge, the mail merge fields are filled with information from your address list. 
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After you connect your labels to your address list, you are ready to add placeholders that indicate where the 

addresses will appear on each label. You can also type text that you want repeated on each label, such as a 

company logo or your return address on a shipping label. 

The placeholders for the addresses are called mail merge fields. Mail merge fields in Word correspond to the column 

headers in the data file that you choose. 

 

 

 Columns in a data file represent categories of information. Mail merge fields that you add to the labels are 

placeholders for these categories. 

 Rows in a data file represent records of information. Word generates a label for each record when you perform a 

mail merge. 

 

By putting a mail merge field in the original label that you configured in the label main document, you indicate that you 

want a certain category of information, such as name or address, to appear in that location. 

 

 NOTE   When you insert a mail merge field into the label main document, the field name is always surrounded by 

chevrons (« »). These chevrons do not show up on the final labels — they just help you distinguish the fields in the 

label main document from the regular text. 

What happens when you merge   
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When you perform the mail merge, information from the first row in the data file replaces the fields in the first label. 

Then, information from the second row in the data file replaces the fields in the second label, and so on. 

 

Working with fields: Examples   

When you design labels, you can link any column heading from your data file to a field in a label. 

For example, suppose you have a subscriber list to your newsletter, and your data file includes a column, called 

ExpireDate, that stores the date that each subscription expires. If you insert an «ExpireDate» field in the label main 

document before you run the merge, that information is added to each mailing label. 

You can combine fields and separate them with punctuation marks. For example, to create an address, you can 

configure the fields in the label main document as follows: 

«First Name» «Last Name» 

«Street Address» 

«City», «State» «Postal code» 

For combinations that you use frequently, like address blocks and greeting lines, Word provides composite fields that 

group a number of fields together. For example, the Address Block field is a combination of several fields, including 

first name, last name, street address, city, and postal code. 
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You can customize the content in each of these composite fields. For example, in the address, you may want to 

select a formal name format (Mr. Roger Harui). In the greeting, you might prefer to use "To" instead of "Dear." 

Map the mail merge fields to your data file   

To make sure that Word can find a column in your data file that corresponds to every address element, you might 

need to map the mail merge fields in Word to the columns in your data file. 

To map the fields, click Match Fields in the Write & Insert Fields group on the Mailings tab. 

 

The Match Fields dialog box appears. 

 

The elements of an address are listed on the left. Column headings from your data file are listed on the right. 

Word searches for the column that best matches each element. As the graphic illustrates, Word automatically 

matched the data file's Surname column to Last Name, but Word was unable to match other elements, such as First 

Name. 

In the list on the right, you can select the column from your data file that matches the element on the left. In the 

graphic, the Name column is now matched with First Name. It is okay that Courtesy Title, Unique Identifier, and 

Middle Name are not matched, because the mail merge label does not need to use every field. If you add a field that 

does not contain data from your data file, it will appear in the merged document as an empty placeholder — usually a 

blank line or an empty block of space. 
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Type the content and add the fields   

1. In the original label that you configured in the label main document, click where you want to insert the field.  

2. Use the Write & Insert Fields group on the Mailings tab.  

 

3. Add any of the following:  

Address Block with name, address, and other information 

1. Click Address Block.  

2. In the Insert Address Block dialog box, select the address elements that you want to include and the 

formats that you want to apply, and then click OK.  

3. If the Match Fields dialog box appears, this means that Word is unable to find some of the 

information that it requires to complete the address block. Click the arrow next to (not matched), and 

then select the field from your data source that corresponds to the field that is required for the mail 

merge.  

Individual fields 

 

4. On the Mailings tab, in the Write & Insert Fields group, click Insert Merge Field.  
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5. In the Insert Merge Field dialog box, do one of the following:  

� To select address fields that will automatically correspond to fields in your data source, even if 

the names of those fields are not the same as the field names in Word, click Address Fields.  

� To select fields that always take data directly from a column in your data file, click Database 

Fields.  

6. In the Fields box, click the field that you want.  

7. Click Insert, and then click Close.  

8. If the Match Fields dialog box appears, this means that Word is unable to find some of the 

information that it requires to insert the field. Click the arrow next to (not matched), and then select 

the field from your data source that corresponds to the field that is required for the mail merge.  

Custom fields from Microsoft Office Outlook contacts 

9. In Outlook Contacts, on the View menu, point to Current View, and then click Phone List.  

10. Right-click a column heading, and then click Field Chooser.  

11. In the drop-down list at the top of the Field Chooser dialog box, select User-defined fields in folder.  

12. Drag the field that you want to add from the dialog box to the column headings. A little red arrow helps 

you place the field in the location that you want. 

 

 NOTE   You can add a new field in the Field Chooser dialog box by clicking New at the bottom. 

13. After you add all of your custom fields to the view, close the Field Chooser dialog box.  

14. To remove a field that you do not want included in the mail merge, click the field name in the column 

heading in Phone List view, and drag it off the column heading. 
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15. In Outlook Contacts, select individual contacts by holding down SHIFT and clicking to select a range, 

or by holding down CTRL and clicking to select individual contacts. If you want to include all the 

contacts currently visible in the view, do not click any contacts.  

16. On the Tools menu, click Mail Merge.  

17. If you selected individual contacts to include in the mail merge, click Only selected contacts. If you 

want to include all the contacts that are currently visible in the view, click All contacts in current 

view.  

18. If you configured the Phone List view so that it displays exactly the fields that you want to use in the 

mail merge, click Contact fields in current view. Otherwise, click All contact fields to make all of 

the contact fields available in the mail merge.  

19. To generate a new main document for the mail merge, click New document. Otherwise, click 

Existing document, and then click Browse to locate the document to use as the main document.  

20. To save the contacts and fields that you selected so that they can be reused, select the Permanent 

file check box, and then click Browse. Outlook saves the data in a Word document (.doc or .docx for 

Word 2007 or later) as comma-delimited data.  

21. Select Mailing Labels.  

22. Click OK. After the document opens in Word, on the Mailings tab, in the Write & Insert Fields group, 

click the arrow next to Insert Merge Field, and then click the fields that you want to add to the label 

main document. 

4. After you finish setting up the first label the way you want it, in the Write & Insert Fields group, click Update 

Labels.  

Word replicates the layout of the first label to all the other labels. 

  NOTES   

 You cannot type merge field characters («« »») manually or use the Symbol command on the Insert menu 

in Word. You must use mail merge.  

 If the merge fields appear inside braces, such as { MERGEFIELD City }, Word is displaying field codes 

instead of field results. This doesn't affect the mail merge, but if you want to display the results instead, right-

click the field code, and then click Toggle Field Codes.  

Format the merged data   
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Database and spreadsheet programs, such as Access and Excel, store the information that you type in cells as raw 

data. Formatting, such as fonts and colors, that you apply in Access or Excel is not stored with the raw data. When 

you merge information from a data file into a Word document, you are merging the raw data without the applied 

formatting. 

To format the data in the document, select the mail merge field and format it, just as you would format any text. Make 

sure that the selection includes the chevron characters (« ») that surround the field. 

 Top of Page 

Step 6: Preview and print the labels 

After you have added the fields to the original label that you configured in the label main document, you are ready to 

preview the mail merge results. After you are satisfied with the preview, you complete the mail merge and print the 

labels. You can then save the label main document for future use. 

Preview the mail merge 

You can preview your labels and make changes before you actually complete the mail merge. 

To preview, do any of the following in the Preview Results group of the Mailings tab: 

 

 Click Preview Results.  

 Page through each label by clicking the Next Record and Previous Record buttons in the Preview Results 

group on the Mailings tab.  

 Preview a specific label document by clicking Find Recipient. 

 NOTE   Click Edit Recipient List in the Start Mail Merge group on the Mailings tab to open the Mail Merge 

Recipients dialog box, where you can filter the list or remove recipients from the merge if you see records that you 

do not want to include. 
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 NOTE   Word uses a table to lay out a sheet of labels on the page. As you page through the labels, the active record 

is displayed in the first cell of the table, with the following records displayed in subsequent cells. 

Complete the mail merge 

To print the labels, do the following: 

1. On the Mailings tab, in the Finish group, click Finish & Merge, and then click Print Documents.  

 

2. Choose whether to print the whole set of labels, only the label that is currently visible, or a specific subset of 

the labels. 

To change individual labels, do the following: 

1. On the Mailings tab, in the Finish group, click Finish & Merge, and then click Edit Individual Documents.  

 

2. Choose whether you want to edit the whole set of labels, only the label that is currently visible, or a specific 

subset of the labels. Word saves the labels that you want to edit to a separate file. 
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Step 7: Save the labels for future use 

Remember that the merged labels that you save are separate from the original label that you configured in the label 

main document. It is a good idea to save the label main document itself if you plan to use it for another mail merge. 
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When you save the label main document, you also save its connection to the data file. The next time that you open 

the label main document, Word will prompt you to choose whether or not to merge the information from the data file 

into the label main document again. 

 If you click Yes, the document opens with the information from the first record that was merged in.  

 If you click No, Word breaks the connection between the label main document and the data file, reformats 

the label main document as a standard Word document, and replaces the fields with the unique information 

from the first record. 

 


